For the Student
Lesson 6: Bitmap and Vector Effects in Collage

Introduction

During this lesson, you will learn to work with bitmap and vector effects to create a collage of images and text on a chosen topic. The exercise project will be created in CorelDRAW, but you will use the techniques you have learned in the exercises and tutorials to create an original collage in CorelDRAW, PHOTO-PAINT, or a combination of the two programs. The original project collage(s) may be done individually or as a group project on the topic of your choosing or a topic assigned by your instructor. The completed collages may be displayed in your classroom or in another venue.
At the end of the research and exploration phase, you should be able to answer several of the essential questions about using effects and about the use of the collage technique. You may also explore the history of collage in art and/or the use of collage in advertising and marketing.
Essential Questions:

These questions will help guide your explorations during this lesson.

CorelDRAW Graphics Suite questions for this project
What kinds of effects can be applied to vector objects?

What are the limitations on the types of objects that vector effects may be applied to?

Where are the various options for vector effects located?

What kinds of effects can be applied to bitmap objects?

What are the limitations on the types of objects that bitmap effects may be applied to?

Where are the various options for bitmap effects located?

Which program in the CorelDRAW Graphics Suite is best suited for applying the various effects? Why?

Questions about collage
What is a collage?

What is the history of collage in art and design?

Besides fine artists, who uses collage in today’s society?

To what types of subjects might the collage technique/treatment lend itself as an effective tool of expression?

Why might a collage of images be effective in marketing and advertising campaigns?

What sorts of elements may be added to a collage from within the CorelDRAW suite?

What tools or techniques might you use to enhance your project after it is printed?

Assignments:

1. Students explore working with bitmap and vector effects using the tutorials and worksheets provided along with Help system articles.

2. Students work through Sample Projects 6A and 6B.

3. Students use the various tutorials and Sample Projects 6A and 6B as a springboard for group discussion and research on the history and effective use of collage based on the Essential Questions. The teacher may break larger classes into groups and assign certain questions or topics to each group. The groups should then report the findings back to the whole class. The teacher may also choose to lecture on some of these subjects.
4. Students use the information they have gained in Assignments 1-3 to create one or more original collage projects on the topic of their choosing or on topics assigned by the instructor. Collage projects may be done individually or in groups as assigned by the instructor. The finished projects may be displayed in the classroom or in another venue.
Assignment 1 – Getting started with Effects
for Vector and Bitmap objects
Fill in the worksheets as you work through the steps below.

Step 1 – A few exercises
Work through Exercise 1 to practice using several effects on bitmap objects.

From the CorelDRAW User Guide or Help review the following articles:

Adding 3D effects to objects

Changing the transparency of objects
Working with Bitmaps (in CorelDRAW)
In the PHOTO-PAINT section of the user’s guide or help, read:


Changing color modes


Working with lenses


Working with Masks


Applying special effects.

Step 2 – The Corel PHOTO-PAINT Effects
Import a photo or other bitmap in Corel PHOTO-PAINT. Several are included in the Resources folders for this lesson.
Browse the Effects menu, noting how it is similar or different from the CorelDRAW Effects or Bitmap Effects menu. You may need to use a new bitmap for several of the effects. Save your work after each change. If an effect cannot be applied to your bitmap, use the help menu to discover why. (Usually it has to do with the color depth.) Use the help menu as needed to explore the list and discover what each effect does.

From the Window ->Toolbars menu, check the Effects Toolbar. How do the effects on this menu differ from the effects listed in the Effects menu? These are known as Local Effects. Explore each tool and make sure you know its use. Open the Hints docker for help with each tool as needed.
Assignment 2 – Sample project 6A and 6B
There are two parts to this assignment. The first are fairly generalized instructions for a simple collage of flower images. The second is a more specific and complex exercise in creating a Sport collage. Different techniques are used in the two exercises. Later, you will be asked to create a collage of your own. You may use a combination of techniques from either of these exercises.
Introduction – Flower collage
In this exercise, you will create a very simple collage in CorelDRAW incorporating several photos powerclipped into a text object. Read through this process to the end where an example is given, then start working with step 1. Your collage will not be the same as anyone else’s.
Step 1

Import five or six photos into CorelDRAW. Some images are included with this lesson to create the image below. Resize and edit as needed to get all the photos both visible and inside the page border. Save your document.
Step 2

Use the eraser tool or crop tool to crop around the main subjects of the photos as needed. The crop tool will create rectangular cropped images. The eraser tool allows you to crop into the image in an irregular fashion. Once you have used the eraser, you may wish to switch to the Shape tool to modify your outline for more control. The Eraser and Shape tools do not actually cut off portions of the image, they simply make them not visible. You will have the full bitmap in your file for later editing. This can leave a rather large file size if you use several bitmaps. In general, it is a better idea to resize and do rectangular cropping in PHOTO-PAINT first before importing into CorelDRAW.

Save your document after each photo has been processed.
Step 3
Chose one dark color from the photos – preferably a color from the main photo or that most of the photos have in common. Use the eyedropper tool to sample that color, then create a background rectangle and fill it with that color. Place this rectangle behind all the photos.
Step 4

Arrange the photos over the background rectangle. You may wish to use one photo as a background image behind the other photos. Graphical elements may be added along with and between your photos. You may also wish to apply bitmap effects to one or more images. Save your work frequently. Some bitmap effects may take considerable time and computer resources to process. It may be quicker to import a photo into its own document and do the editing and effects there, then import that finished image into your collage document.
Step 5

When everything is arranged, group the entire thing except for the background rectangle or, if there is space between your images, duplicate the background rectangle and group the duplicate with your images leaving one rectangle outside the group.

Step 6

Using the text tool and a bold font, type the subject of your images. Convert the text to curves. Resize the text so that it takes up most of your page inside the ungrouped rectangle. You may wish to give the text an outline in a color to contrast or compliment the background color. The fill color doesn’t matter.
Step 7

Resize the group of images so that it is just a bit larger than the text on all sides. Keep the group selected.
Step 8

From the Effects menu, choose Powerclip. When the black arrow appears, click the text object.
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Depending on your subject and the effect desired, you may wish to include text objects with different vector or bitmap effects within the powerclip group or you may wish to use the powerclip group over another set of images and text objects. In the image above, a background photo was treated with the Stained Glass effect, then other photos placed over it and cropped using the eraser tool. Some had a bit of transparency or drop shadow applied.
Placement of the images in regards to the final container should be considered before the powerclip process is done. If you decide you want to edit or move the contents of the powerclip, you have two options. You may adjust where the entire contents lies inside the container by right clicking and choosing Edit Contents. You can also edit individual parts of the contents in this mode. When done, right click again and choose Finish Editing contents at this level.

Your other choice is to right click and choose Extract contents which completely separates the contents from the container.
More techniques – Sample Project 6B – The Sports Collage

Start with a New blank document in Landscape orientation, RGB defaults. Collage is typically a mixed media image put together from scraps of various things. The results can be used in many applications including fine art, scrapbooking, and textiles. Using the CorelDRAW Graphics suite, you can imitate this look by importing images with different textures and styles. Below are the steps used to create this Sports collage using images included in the Resources folder of this lesson.

[image: image2.emf]


Set the Background:

Import background images by opening the folder then dragging and dropping onto CorelDRAW the following images:

PH00347.jpg

PHoo336.jpg

PH00308.jpg

PH00340.jpg
In CorelDRAW X5 and X6, you can use the Connect Docker to navigate to the folder and import the images.

Place each one on a separate layer by creating new layers in CorelDRAW and dragging each image onto a different layer in the Object Manager. Label the layers. You may also wish to rename the bitmaps and groups throughout this exercise in the Object Manager so it is easier to keep track of them.

For the file included with this lesson, each bitmap has been resampled to 100 dpi after it was placed in the the image and scaled to its final size. That allows for a smaller file size. For printing, you would probably want at least 150 dpi or more.

Rotate the Green rectangular canvas frame image 90 degrees and place it centered on the page. Move its layer to the bottom of the stack.
Scale the orange plaster peel background to about 67% - to be even with the top and bottom of the green frame background and align it to the right side. From the Bitmap menu, choose Creative, then Frame and use frame Square_2.cpt in the default state except use the eyedropper in the dialog to choose a green from the green rectangle background for the frame color. Apply a uniform transparency of about 27 just so the back frame peeks through the image. This should be your next layer closest to the bottom.
Save your work frequently while doing this exercise!
The next layer up should be the bricks. Leave these full size. Give them a uniform 30% transparency. Draw a rough freehand shape using the green background layer as a guide. Make the shape smaller than the background image is tall and about as wide as half the frame. Make sure the shape is a closed shape. Fill with any color, just to make selecting it easier, and give it NO outline. If you need to add a few nodes to add some roughness to it, go to node editing mode and do so. Place this new shape over the bricks so that the bricks show on all sides. Select the brick image, go to the effects menu, choose Powerclip and Place Inside... then click on the shape you made. Notice that the bricks take on the color you filled the object with, but the finished image is no longer transparent. Click the Null color well to remove the fill color for the container shape. This allows the contents to be transparent. Now rotate and resize the brick shape to a good spot.
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Scale the Red/White/Blue frame to 50%. Apply a uniform 50% transparency. Rotate 30 degrees and place in the upper left corner so the top corner escapes the green frame and the bottom right corner pokes into the orange plaster peel frame.
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Select the orange plaster peel image with the Shape tool and add nodes where the Red/White/Blue frame crosses the shape. Add one more node in between those two and drag it out to the corner of the Red/White/Blue frame to crop it back so you don't see the green frame under the white.
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A screenshot of the Object Manager when the project is completed appears at the end of these instructions. You may wish to use it for a reference.

Place the "content" images:

0200F002.cpt – (volleyball) Place on lower right corner of the Green Rectangle Background layer below the Orange plaster peel, above the background image. Rotate 338 degrees. Scale 223%.

0200F006.cpt – (football) Place in the upper left corner on the same layer. Scale to about 116%. Crop the top of the arm to be even with the green mat edge.

CGS07407.cdr - (baseball) Upper right corner of the same layer. Scale down to about 23%. Rotate about 75 degrees.

0200F026.cpt – (hockey player) Place on the Orange plaster peel layer, but underneath the Red/White/Blue frame. This fades the image a bit. Scale up to about 246% and rotate about 38 degrees so the hocky player looks framed by the Red/White/Blue frame.

CGS07790.cdr – (soccer) Place on the Orange plaster peel layer. Scale down to about 28%. Start out on the desktop rather than the page and ungroup. In the Object Manager, click on the first purple filled curve, then Shift click on the last purple filled curve in the list - 9 objects should be selected. Double click the fill swatch in the Status bar to open the Uniform Fill dialog. Switch to the RGB color model, then choose a much deeper shade of green similar to the greens already in the image - R57,G102,B44. OK out of the dialog. Regroup all the objects and place over the orange plaster peel background. Apply a 40% uniform transparency to take the hard edge off the contrast.

0200F025.cpt – (skateboarder) Place on the Bricks layer, above the bricks. Scale to about 387 degrees.

PH0063.jpg – (basketball) Place as the top object on the Green rectangle background layer. Scale to about 47% and place almost but not quite in about the middle of the entire image. Notice that it imports with a solid white background. Go to the Bitmap menu and choose Bitmap Color Mask. A docker opens. Use the eyedropper to select the white color. Set the tolerance to 80% and click Apply. This makes the background color invisible. (If you cannot see the Apply button, it may be hiding behind another docker.)
Text

Create a new layer between the red/white/blue layer and the Orange plaster layer and call it "Text". Place the following quotes on that layer as Artistic Text.

It may be that all games are silly.  But then, so are humans.  ~Robert Lynd - Place this text on an elliptical path around the soccer player graphic in a dark shade of the orange plaster. (See the next text quote for a tip on doing that.)

Sport is a preserver of health.  ~Hippocrates Place on an angle complimentary to the skateboarder. Apply a color from the brick, then duplicate. Move the duplicate just barely up and to the left and fill with a darker shade of the darkest green in the backgrounds. (Use the eyedropper to grab a green, then hold the Ctrl key down while dragging the black color well over the text and dropping when the cursor shows a solid black square. Each time you do this, it will add 10% of the color you just dragged to the existing color.)

Sports is human life in microcosm.  ~Howard Cosell Place at the bottom, aligned right. Stretch to fit the right area. Apply a drop shadow.

Finish it all off by drawing a rectangular frame around everything. Center it on the page. Give it an 8pt outline.
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Assignment 3

Discussion and Research – Collage
Use the various tutorials and Sample Project 6 as a springboard for group discussion and research on the history and effective use of collage based on the Essential Questions. Your teacher may break larger classes into groups and assign certain questions or topics to each group. The groups should then report the findings back to the whole class. Your instructor may also choose to lecture on some aspects of these subjects.

Assignment 4
Create an original collage
Use the information you have gained in Assignments 1-4 to create one or more original collage with the theme of your choosing or as assigned by your instructor. This should be different and more complex than the flower collage you created in Assignment 2, but probably not much more complex than the Sport collage. You may use CorelDRAW, PHOTO-PAINT, or a combination of both to create the desired results.

If you are assigned to create this as a group project, you will want to decide the theme of your project and assign roles to each group member including gathering of photos and graphics, editing and applying effects to the various elements, arranging the elements and combining them into the finished project.
Keep track of the processes you use to create your project and be ready to explain how each part of the final project was created. You may wish to take notes to create a set of instructions similar to those in Assignment 2.
Your collage should contain at least the following requirements:

1. At least three photos, photo objects, or other bitmaps
2. At least two vector objects, not counting text
3. At least one text object (may be converted to curves, but should remain readable)

4. At least two bitmap effects
5. At least two vector effects

6. The final collage should illustrate the theme you have chosen.
Your final collage may be completely created in CorelDRAW or Corel PHOTO-PAINT and then printed, or portions of it may be created there, then printed and the final put together by hand. Consider how you can make your final product more appealing or further express the theme by post printing treatments.

Your class should choose a venue to display your finished artwork.
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